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Performing Searches

The QRZ database can be searched in any of five different ways - by Callsign, by
Name, by City/State, by Street Address or by Zip Code. The way in which the
database is searched depends up the current Lookup Mode selected from the
menu at the top of the Main Screen. When a lookup mode is selected, one or
more Key Boxes appear which may be filled in with the data that you're searching
for.

For a step-by-step review of how to use each Lookup Mode see:

Looking up Callsigns

Looking up Names
Looking up Cities and States
Looking up Zipcodes

Looking up Street Addresses




Looking up Callsigns

Callsigns may be looked up either by their suffix or by the whole callsign. For
example, to lookup AA7BQ, the first step is to go to the menu at the top of the
Main Screen and select Lookup and then Callsign. When this is done, a single
Key Box will appear which has the word Callsign: next to it. In this box, type in
AA7BQ and then click on the Search button. All the available information for
AA7BQ will shown on the Display Panel.

To lookup a range of callsigns, a suffix key must be used. After typing in a
callsign suffix into the Callsign Key Box, begin by clicking on the Search button.
The first callsign matching the given suffix will be shown. To see each additional
callsign which matches the suffix, click on the Next button. You may continue
clicking on the Next button until all the last matching callsign has been shown.
Each time you click on the Next button, the Match Counter will update to show
you the number of callsigns which matched the given suffix.

Suppose you have a suffix and you simply want to know how many callsigns
match it. This can be easily done by entering in the suffix as mentioned above
and then by clicking on the Count button. The Count button counts the number
of matching records but does not return any of the data associated with them.
While all of the buttons affect the Match Counter, the Count button is the fastest
one for returning just the total count.

The Continue button is very similar to the Count button except that it returns and
displays the data associated with each matching record. If a Log File is open or
if the Printer is ON, the Continue button also sends data to them as well. The
Continue button is useful for visually spotting trends in the data as it rolls by on
the screen (unless of course your computer is really fast and you can't make out
what's rolling by on the screen...).




A callsign suffix is the part of the callsign which includes the area number and
the letters which follow it. For example, a, ab, abc and 7abc are all valid
suffixes. Using a suffix of just the letter A will match callsigns like: AAT7A,
NR2A, WUTA, etc.. Using a suffix of '7ABC' finds all callsigns which end in
7ABC such as: N7TABC, W7ABC, KB7ABC, and so on. You cannot use a
number by itself as a suffix.



Looking up Names

The procedure for looking up names is very similar to that used for Callsign
lookups. To begin, you must first go to Main Screen menu and select Lookup
and then Name. Next, two key boxes will appear with one labeled Last Name
and one labeled First Name. When searching for names, remember that typing
in a key for the Last Name is required and for the first name it is optional. In the
key box labeled Last Name, type in the last name of the person or persons that
you wish to look up. Last and first names may contain spaces in them such as
"VAN HORN", MARY JANE or "JEAN LUC".

When you use the star (*) at the end of a last name, you can match a whole
range of names. For example, a last name specified as L* would return all
callsigns of people whose last name begins with the letter L. You can also type
several characters before the star as in: SMI*, which would match all names
beginning with SMI as in: SMITH, SMITTY, SMIGEL, SMILEY an so on.

Note that the star (*) function has been superceded by a new Options Menu item
called Approximate Matches. When Approximate Matches is on, all Name
and City lookups act as if the star were typed.

After you've typed in the Last Name, you may then enter a desired First Name
and optionally a Middle Initial. All first names are considered 'wild' and are
treated as if a star had been typed at the end. For example, entering FRED as
the First Name will return all records whose last name field matches the given
Last Name key and whose first name begins with the letters FRED such as
FRED, FREDERICK, FREDERICO, etc..

Middle Initials may be entered in after the first name such as FRED L, or
RODNEY J, etc.. If the first name is a two-word name like PEGGY SUE then
there can be only one space between PEGGY and SUE. There can be only one
middle initial.

Once a match is found using any of the above methods, the Next, Count,
Continue and FastLog buttons can be used in the same manner as mentioned
under Looking up Callsigns.

Note: Name lookups are available for US callsigns only.



Looking up Cities and States

The procedure for looking up cities and states is very similar to that used for
Callsign lookups. To begin, you must first go to Main Screen menu and select
Lookup and then City/State. Next, two key boxes will appear with one labeled
City and one labeled State. When searching for cities, remember that typing in a
key for the state is required. Typing in the city name is optional, in which case
all records for a given state are returned.

In the key box labeled City, type in the name of the city or town that you wish to
look up. City names may contain spaces in them such as 'SAINT LOUIS". As
it is with Last Names under Looking up Names, the City name may end with a
star (*) meaning that all records matching the initial pattern will be returned. You
will likely find that quite a few US license records have misspelled cities in them
making the star (*) method very useful.

In the key box labeled State, type in the two-letter state code. The State code is
required.

After typing in your keys, click on the Search button to start the search. Once a
match is found using any of the above methods, the Next, Count, Continue and
FastLog buttons can be used in the same manner as mentioned under Looking

up Callsigns

Note: City and State lookups are available for US callsigns only.



Looking up QSL Card Images

To browse the digital QSL Card Image collection, select Lookup->Images from the main menu. If
you would like to add your QSL card to the next edition of the QRZ CDROM, there are several
ways to do it (shown below). The image content can be just about anything you would like to
represent your callsign. It can be a picture of your QSL card or a photo of your shack, your
favorite antenna, etc. We reserve the right to refuse any image which we think is inappropriate.

Using the Internet: Anonymous FTP
If you have FTP access, send your digital QSL image (not to exceed 500
x 300), then package it up into a .ZIP file and ftp it to ftp.qrz.com. Place
the file in our /tmp directory. Be sure and name your file xxOxxx.gif
where xx0xxx is your callsign. .GIF format files are preferred, and your
image will be converted to .GIF format if necessary.

URL:

If you have an image already available via the World Wide Web, just drop
us an e-mail and tell us where it can be found using our browser. Please
dont ask us to FTP your image unless it can be reached using a regular
browser (such as Netscape).

Email:

You can email your .GIF image to us. For best results, use UUENCODE
as the format, we sometimes have problems with other types of
attachments.

Regular Mail: Floppy Disk
You can mail your favorite image on floppy disk. MSDOS 3 1/2 inch
disks are preferred. You may send us as many images as you like, but
unless they are really interesting we will only print one of them.

Hard Copy Photo or Card
We can digitize your hard copy photo or card on our color scanner. Just
send it to us and well see what we can do.

If your image is accepted, you should see it on the QRZ internet server (http:/www.qrz.com)
within a few weeks.

We do not normally return cards and photos submitted by regular mail. If you must have your
card or photo returned, please include a self-addressed stamped envelope along with your
letter.

Please do not send us copyrighted photographs or images.



Looking up Email Addresses
This version of the QRZ database contains over 12,000 email addresses

To lookup email addresses only, choose Lookup -> Email from the main menu. In the box
provided, enter any callsign. If the email for this callsign is known, it will be displayed in the
email address box. Email addresses are automatically displayed in the lower part of the main
panel as they are found. Dont be surprised if only a few addresses can be found. Although
we list nearly a million callsigns, only about 1 in 100 have listed their email addresses with QRZ.
As of the printing of QRZ Volume 6, approximately 12,200 addresses are in the database.

To add your email address to the QRZ master database so that it appears in the next edition of
the QRZ CDROM, simply send an email to updates@qrz.com with the following message:

To: updates@qrz.com
Subject: my email address

qrz_email YourCall YourEmail@address

Just replace the YourCall with your callsign and the YourEmail@address with your correct e-mail
address. Please do not add any additional characters and/or punctuation to the qrz_email line
besides those found in your e-mail address.

Notes: URLs are also accepted provided they begin with http://.. and do not exceed 50
characters in length. Only one listing is allowed per person. If you have World Wide Web
(WWW) access, you can input your email address directly by visiting http:/www.qrz.com



Looking up Zipcodes

The procedure for looking up zipcodes is very similar to that used for Callsign
lookups. To begin, you must first go to Main Screen menu and select Lookup
and then Zip Codes. Next, two key boxes will appear with one labeled Zip
From and one labeled Zip To. The Zip From key is required and the Zip To key
is optional.

The Zip From key is the key to begin matching zipcodes from, which will return
all zipcodes which are equal to Zip From. When the Zip To key is used,
matching continues up to and including all those records which match the Zip To
key. The Zip To key, if used, may not be less than the Zip From key. After
entering in the Zip From key and the optional Zip To key, click on the Search
button and proceed with other operations as desired.

Once a match is found using any of the above methods, the Next, Count,
Continue and FastLog buttons can be used in the same manner as mentioned
under Looking up Callsigns .

Note: Zipcode lookups are available for US callsigns only.



Looking up Street Addresses

The procedure for looking up street addresses is identical to that used for
Looking up Cities and States except that a third key box, the Street key, is
included. As with the city lookup, the State field is required. All other fields are
optional. It is possible to look up a street name without specifying the city in
which case all streets in the state matching the given street name are returned.

The method used for looking up street addresses is to first perform a city/state
match and then check to see if the record contains the given street key.
Because each record is individually scanned, the street search can take a great
deal longer than any other type of lookup under QRZ.

When choosing a Street key, try and be as least specific as possible since a
great many street names are misspelled and/or spelled differently across the
database. For example, a street name might be CALLE PORTAL but may be
found in the database under both CALLE PORTAL and CALLEPORTAL (one
word). Your best bet is to look for the word PORTAL and hope for the best.

Attempting to lookup a specific numbered street address will be nearly hopeless
in all cases since there is such a great variety in the way addresses are written.
For example, if a person lives on 1234 West Main Street, the database (and the
FCC records) might contain "1234 W MAIN STREET", "1234 WEST MAIN ST",
or "1234 W MAIN ST", all of which are unique as far as the computer is
concerned.

The Street Search method looks only for exact matches so unless you have the
patience to try every possible combination, it is suggested that (as in the example
above) you just look for MAIN, save your results to a Log File and then use the
Log File Editor to further refine your search.



Lookup Modes

By specifying a Lookup Mode, you indicate what type of data your'e looking for:

Lookup
Mode
Callsign
Name

City / State
Zip Code

Street

See also:

Is used to search for...

A particular callsign or range of callsigns

A particular or similar name

All callsigns within a given city and / or state

All callsigns within a given zipcode or range of
zipcodes

A street address or street within a given city and / or
state

Looking up Callsigns
Looking up Names

Looking up Cities and States

Looking up Zipcodes
Looking up Street Addresses




Key Boxes

The Key Box area of the Main Screen is used to fill in the desired search key for
a particular operation. Depending upon the current Lookup Mode, different key
boxes will appear.

The Key Boxes may be cleared by clicking on the Clear button. As you move
about the database, the Key Boxes may be automatically filled with the contents
of the current record if the option value AutoFill is turned on.

See also: Setting Program Options.




The Search button is always used to begin a lookup after a key
has been entered. If the Search button finds a match then the
Count, Next, and Continue buttons become active.

See also: Performing Searches



The Count button causes the program to go out and see how
many records exist which match the current key. The results are
displayed in the Match Count box. No record data is returned.
The Count button is not active until the Search button has returned
the first match.

See also: Performing Searches




The Quick Print button sends the record currently being displayed to the printer. This button is
intended primarily for dot matrix printers which are capable of printing one
line at a time. For laser and/or inkjet printing, see Printing.



The Card (Picture) button is used to activate the image viewer window. When an image file
exists for the callsign currently being displayed, the Card button changes its name to Picture
showing that an image is available.



The Next button fetches the next record which matches the
current key, after the Search button has found the first record.

See also: Performing Searches



The Continue button acts just as if the Next button were
repeatedly pressed until the last record matching the given key(s)

has been displayed. The Continue button is not active until the
Search button has found the first match.

See also: Performing Searches




The Clear button clears all of the Key Boxes and the Return Data
Panel.



This is the Scroll Bar. For more info see: Using the Scroll Bar



The FastLog button is only active when either the Printer is ON
or when a Log File is open. The FastLog button acts just like the
Continue button except that no data is shown on the screen.
Using the FastLog button quickly dumps the selected data to a file
or to the Printer. The FastLog button is not active until the Search
button has found the first match.

See also:
Performing Searches




Using the Scroll Bar

The Scroll Bar located beneath the Key Boxes is used to casually
browse through the database. When you use the Scroll Bar, the current
search is cancelled and you enter into the database browsing mode.

Using the Scroll Bar is not the same as using the Next or Continue
buttons. The Next and Continue buttons look for the next match while
the Scroll Bar simply returns the next record, which might not match the
current key at all. To see the next match for the current search key, use
the Next button. (Sorry, but there is no way to view the previous match to the current
search key, although sometimes the Scroll Bar may show it to you.)

Clicking on the arrows at the left or right of the Scroll Bar moves the
database back or forward by one record in either direction. Clicking on
the inside of the scroll bar moves the database in jumps of 100 records.
Dragging the scroll bar button moves the database by huge amounts.

Note: Data viewed using the Scroll Bar is not written to the Log File or to
the Printer.




The Data Panel is provided as a source for cutting database information (using
the Edit->Cut menu item) which also places it in the system clipboard. This
information may then be pasted into other applications such as word processors,
text editors and other databases. All of the QRZ database information is read-
only and changes made in the Data Panel are not saved.



The Message Panel is used to show when Log Files are open and when the Printer is turned
ON.




The Display Panel is the main data display area for QRZ. There
are no user controls on the Display Panel.



The Main Screen Menu

Menu
Name
File
Edit
Lookup
History
Options

Help

Purpose

Working with Log Files, Printing

Copy and Paste to/from the Data Panel and Key Boxes

Sets the Lookup Mode (Callsign, Name, City, Zipcode, Street)
Contains a History list of the last 16 callsigns found

Setup for the Printer, Program Options (AutoFill, Output Formats,
etc.)

This Help file




History

The History menu contains the last 16 callsigns which were returned by a
successful hit by the Search button. Only the first match is saved, all other
matches returned by Next, Continue and FastlLog are ignored. The history list
can be cleared using a button on the Options screen.



AutoFill

AutofFill is a capability which may be turned ON or OFF using the Options menu.
When AutoFill is on, the relevant Key data is extracted from the currently
displayed record and placed in the proper Key Boxes.



The Match Counter displays the number of records which have been shown that
match the given Keys. Clicking the Search button always resets the Match
Count to zero.




Setting Program Options

The Options setting on the Main Screen Menu is used to bring up the Options
Settings screen. This screen is divided into two main parts, the General panel
and the Output Style panel. In addition, there is a button, Clear History which
can be used to clear the list of entries under the History menu item.

All of the settings on the Options Settings screen are saved and remembered the
next time the program is run

In the General panel there are several options: AutoFill, Startup Banner, Save
History, Approximate Matches and Number of Lines per Mail Label.

The AutoFill option turns the AutoFill feature on or off.

The Startup Banner option controls whether the QRZ banner
screen is displayed on program startup.

The Save History option controls whether the callsigns on the
History menu are saved and remembered when the program
next runs.

The Approximate Matches setting controls whether records must
exactly match the given search pattern. Example: when
Approximate Matches is ON and the search set to Name
Search, you can enter the letter S in the last name field and
the program will return all last names beginning with the letter
S. With Approximate Matches turned off, specifying the letter
S will find no names since nobodys last name is simply S.

The Number of Lines per Mail Label setting allows you to set the
number of print lines which are output per mailing label. The
minimum value for this setting is 3.

The Output Style panel selects which type of output format will be sent to the
printer or to log files. The current setting of the Output Style panel is reflected by
the information shown in the Data Panel.



Output Formats

There are 5 supported output formats or styles which are selected in the Option
Settings screen:

Style Description
Display 3-line display with all record data shown
Callbook 1-line directory-style display with callsign suffixes
aligned
Mail Label 3-line standard mailing label (plus blank lines)
DBF Comma separated, quoted string raw data output
Raw Raw QRZ internal ASCII database format

These settings affect how the data is printed and/or sent to a Log File. The data output by the
DBF and Raw formats is described in the QRZDLL.HLP and QRZ.HLP technical reference
documents. The Options screen can be used to set the number of lines per Mail Label.



Printing

The printing of data gathered by QRZ is accomplished in one of two ways. First, the
data may be saved to a Log File which can then be imported into your favorite word
processor or database program and printed from there. Secondly, QRZ provides a
direct print method which will print records as they are fetched from the database.

Printing Basics
Quick Printing

If you have a dot matrix printer and you just want to print out a single record, then the
Quick Print button is the fastest and easiest way to print. Quick Print will not, however
give you any control over Font selection or Page layout. To get to the fancier printing
stuff, especially with laser and ink jet printers, read on...

Advanced Printing

First, select the File item and then Print ON from the Main Menu. A highlighted
message will appear on the Message Panel indicating that the Printer is ON. Make your
record selections by using the Search, Next, Continue and FastlLog buttons. Once you
have completed your searches, select File and then Print OFF from the Main Screen
Menu. The last may not start printing until you select Print OFF (for reasons outlined
below).

The printer Font and Page Orientation can be setup using the Print... dialog under the
Options menu.

Note: as of Version 5 of QRZ, there is a new button under the Options->Print menu
called Flush Printer. Flush Printer will immediately dispatch any partial pages out to
the printer as if Print OFF had been selected (it does not, however, select Print OFF).
Flush Printer also works with the Quick Print button.

Advanced Printing Topics

Windows printing uses the concept of pages in that no data is output to the printer until a
whole page has been assembled in memory. Because of this, when you first turn the
printer on in QRZ, nothing happens. Once youve turned the print function on, the
search results that you get from the database are stored (or spooled) in memory until a
full page is ready. Only then does the system send the information out to the printer.
QRZ never holds more than a single page in memory and will dispatch each page to the
printer as soon as they become ready. If you dont gather enough data for a whole
page, then youll need to select the Print OFF menu item to flush the partial page out to
the printer. As a shortcut, if you want to leave Print ON but print what you have gathered
so far, choose Flush Printer from the Options->Print menu.

The printing function can be either ON, Suspended or OFF. When printing is ON, all
search data is being sent to the printer. When printing is Suspended (using the Print
HOLD menu selection) the data in memory is retained while you decide what to print next.



Finally, when youve searched and found all of the records that you want printed, you
select Print OFF to finish the job. If you have turned the print function ON and then back
OFF again without performing any searches, no blank page will be printed.

Since Windows printing methods are graphics based, laser and ink-jet (and some dot
matrix) printers can choose from a variety of font sizes to print with. Huge characters
can be used to make large labels and very tiny characters can be used to make detailed
lists. Depending on the font and/or font size used, as many as 800 or as few as 1
records might be printed on a single page. The Print Setup dialog allows you to
calculate the number of lines which will be printed per page given the currently selected
font, size and page orientation (Landscape or Portrait). This information is displayed at
the top of the Print... setup window under the Options menu.

QRZs printing abilities can only be described as pretty good in comparison to more
advanced tools such as word processors and spreadsheets. Despite the fact that QRZ
can deal with different fonts, printers and paper sizes. QRZ cannot, for example, print
multiple column listings, it does not number the pages, there is no "Page Preview" and it
does not print headers or generate reports of any kind. It only prints what would have
been sent to a Log File, in the font and size that you select. QRZ does make sure that
no record is split between pages and will start a new page if all the lines of the current
record will not fit on the existing page. If the print lines are too wide to fit on the page,
QRZ will chop them off instead of wrapping around to the next line.

If you are not satisfied with QRZ's printing capabilities, then youll have to save your
searches to Log Files and then use your favorite word processor to format and print the
data as you like. You can expect to see more advanced printing in later editions of
QRZ.

A special note about fonts: QRZ's font selection is limited to the fixed pitch printer fonts
which you have installed on your system. So, even though you might have a hundred
True Type fonts, QRZ can only use the ones which are fixed pitch and will only put up
those types of fonts on the selection menu.



Main Screen Controls and Menus

Click on any part of the graphic below for more information.
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Log Files - Saving Search Results

The QRZ database is very large and can easily generate huge amounts of output data.
QRZ provides a method of saving this data to a user specified file called a Log File that
can then be used for any purpose. For example, you might want to create a list of the
amateurs in your home town and save it as a separate file. Then, you may want to take
this data and put it into your word processor to generate a custom mailing list. The use
of Log Files makes this easy.

The following steps will tell you how to perform an ordinary search and save it to a Log
File.

First, you should already be familiar with Searching and know how to move around in the
database. Next, you should do a couple of dry run searches to help you decide which
records you really want to save. By using the Count and/or Continue buttons you
can quickly get a good idea of how many records your search is going to generate.
Depending on the output format that youve selected, as many as 200 or so bytes can be
generated for each record that is saved to the Log File.

Once you have narrowed your search down to the desired range, select the File and then
the Open Log items from the Main Screen Menu. You will then be prompted for the name
of a file and asked if you wish to overwrite or append to it if it already exists.

Once the file is opened and ready, a Log File Open message will be highlighted and
displayed on the Message Panel.

Next, type in your desired search key and click on Search. After the first match is
returned the Next, Continue, Count and FastLog button become active. Select either
the FastLog (best) or Continue (slower) button to fetch the complete set of matching
records and save them to the open Log File. When finished you may either type in a
new Key and start another search or you can click on File and then Close Log to close the
open log file. Once closed, the highlighted message bar will return to normal. If you
want to add more records later, you can alway reopen your Log File and select the
Append option to add more records to it.

Notes:
Moving the Scroll Bar does not send output to the open Log File. Log File records
are written only as a result of clicking on Search, Next, Continue and FastLog. No
other buttons or controls write to the open Log File.

See also: Editing Log Files,Printing



Editing Log Files

Any of the Log Files which have been written by QRZ may be edited while QRZ
is running (provided that they're not too big). To edit a previously saved Log

File, first select File from the Main Screen Menu and then selecting Edit Log.
Files which are smaller than 50K are handled by NOTEPAD.EXE and larger files are
passed to WRITE.EXE. If you want to use another editor then you must start it up
from either the Windows File Manager or Program Manager application. You
can also use DOS based editors to edit your Log Files.

Note: You should avoid trying to edit log files which have not yet been closed (Close
Log on the File menu). Unpredictable results can occur.



QRZII.LEXE Command Line Options

If you have installed QRZII on your hard disk using the SETUP.EXE program on the
CDROM, you will see that an icon and program group are created on your Program
Manager desktop. This icon serves only as a shortcut to the data stored on the CDROM.
None of the database or indexes are copied to your disc. Since QRZ will run directly off
of the CDROM, it is not necessary to run SETUP.EXE at all if you create your own icon
or shortcut.

When the SETUP.EXE program is run, it creates a program manager icon which directs
QRZ which drive letter to use for the CDROM. This drive letter (for example: D:) is
placed after the program name (QRZII.EXE) and is visible by selecting File and
Properties from the Program Manager main menu, This drive letter instructs QRZII
where to start looking for the CDROM. If you have more than one CDROM on your
system, youll need to launch QRZ with the QRZ CD in the same drive as it was installed
in or else QRZ will give you a friendly error message stating that it was found in a
different place than it was expected.

If QRZII.LEXE is not supplied with a drive letter on the command line, it will simply search
for the first drive containing the path: \callbk\callbkc.dat and use it.

Normally it is best to have a drive letter specified since it speeds program startup. If
you let QRZ find its own database, you can see which drive was chosen by selecting
the Help and About items from the QRZ Main Menu.



QRZ on the Internet

QRZ can be found on the internet with the following services:

Anonymous FTP

ftp:/lftp.qrz.com carries a large collection of shareware, data files, GIF repository

World Wide Web

http://lwww.qrz.com is an Interactive web server with online database lookups with gif image
display, ftp archives, email and DX callsign registration.

Email

QRZ maintains the following email addresses for user correspondence. Except for the authors,
each of the addresses below are automated response servers:

Author  aa7bg@grz.com Fred Lloyd, AA7BQ
Email Registration updates@qrz.com Automated e-mail registration
Email database lookup@qrz.com  Auto. database lookup system
lookups
Product Info info@qrz.com Press Releases






